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INTRODUCTION
There are hundreds of project management software products on the market today.
Unfortunately, many people who own the software have no idea how to use it. It is
important to understand basic concepts of project management, such as creating a work
breakdown structure, determining task dependencies, and so on before making effective
use of this software. Many project teams still use spreadsheets or other software to help
manage projects. However, if you can master a good project management software tool, it
can really help in managing projects. This appendix summarizes basic information on
project management software in general. It also provides a brief guide to using Microsoft
Office Project 2007 (often referred to as Project 2007), the most widely used product.
Appendix B provides a brief summary of @task, the most popular totally online tool.

PROJECT MANAGEMENT SOFTWARE REVIEWS
Figure A-1 provides a screen shot showing the top ten project management

software products based on a June 2009 review by TopTenREVIEWS™. The products
listed in the top ten include:

1. Microsoft Project

2. MindView

3. Project KickStart

4. RationalPlan Multi Project

5. FastTrack Schedule

6. Service Desktop Pro

7. Milestones

8. MinuteMan

9. FusionDesk Professional

10. VIP Team To Do List

Notice that Microsoft Project is number one on the list. Also notice its steep price
of over $500 for a single user. Remember that students can purchase Project 2007 and
other software at greatly reduced rates from sites such as www.journeyed.com (only
$69.98 for Project 2007 Standard in July 2009). You can also normally download free
trials of Project 2007 and other software products.

mailto:@task
www.journeyed.com
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Figure A-1. Top ten project management software product comparisons

Below are descriptions of the criteria for comparing the software products:

Collaboration: How information and issues are communicated with project team
members, including email, conference calls, meetings, web-based locations and more.
Collaboration should be easy to use.

 Resource Management: Project management software should manage and
control the resources needed to run a project, such as people, money, time
and equipment.

 Project Management: The process, practice and activities needed to
perform continuous evaluation, prioritization, budgeting and
selection of investments are key. Proper project management
capabilities provide the greatest value and contribution to the
strategic interest of your company.

 Ease of Use: All project management software has a learning curve,
but the best have functions that are easy to find and simple enough
for anyone to use from Day 1, Project 1.

 Help/Support: Project management software should offer a
comprehensive user guide and help system. The manufacturer should
provide email addresses or telephone numbers for direct answers to
technical questions.1
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In addition to reviewing project management software in general,
TopTenREVIEWS™ also compared online products in a separate category. These
products require an Internet connection for use. Figure A-2 lists the top ten results. The
top fourteen products listed include:

1. @task

2. Daptiv PPM

3. Clarizen

4. Project Insight

5. Celoxis

6. Intervals

7. Projecturf

8. Central Desktop

9. Easy Projects NET

10. eStudio

11. Project Office.net

12. Copper

13. Smooth Projects

14. Zoho Projects

@task took the number one spot. Like most tools in this category, @task
provides the ability to create Gantt charts, numerous reports and views, project
dashboards, and it provides integration with Project 2007 files. One of its unique features
is its support of iPhones. See End Note 1 or visit the Web sites for any of these products
and use a free trial version. See Appendix B for more information on using @task.

mailto:@task
mailto:@task
mailto:@task
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Figure A-2. Top ten online project management product comparisons

BASIC FEATURES OF PROJECT MANAGEMENT
SOFTWARE
What makes project management software different from other software tools? Why not
just use a spreadsheet or database to help manage projects?

You can do a lot of project management planning and tracking using non-project
management software. You could use a simple word processor to list tasks, resources,
dates, and so on. If you put that information into a spreadsheet, you can easily sort it,
graph it, and perform other functions. A relational database tool could provide even more
manipulation of data. You can use email and other tools to collaborate with others.
However, project management software is designed specifically for managing projects, so
it normally includes several distinct features not found in other software products:

 Creating work breakdown structures, Gantt charts, and network diagrams: As
mentioned in this text, a fundamental concept of project management is breaking
down the scope of the project into a work breakdown structure (WBS). The WBS
is the basis for creating the project schedule, normally shown as a Gantt chant.
The Gantt chart shows start and end dates of tasks as well as dependencies
between tasks, which are more clearly shown in a network diagram. Project
management software makes it easy to create a WBS, Gantt chart, and network
diagram.

mailto:@task
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 Integrating scope, time, and cost data: The WBS is a key tool for summarizing
the scope of a project, and the Gantt chart summarizes the time or schedule for a
project. Project management software allows you to assign cost and other
resources to tasks on the WBS, which are tied to the schedule. This allows you to
create a cost baseline and use earned value management to track project
performance in terms of scope, time, and cost in an integrated fashion.

 Setting a baseline and tracking progress: Another important concept of project
management is preparing a plan and measuring progress against the plan. Project
management software lets you track progress for each task. The tracking Gantt
chart is a nice tool for easily seeing the planned and actual schedule, and other
views and reports show progress in other areas.

 Providing other advanced project management features: Project management
software often provides other advanced features, such as setting up different
types of scheduling dependencies, determining the critical path and slack for
tasks, working with multiple projects, and leveling resources. For example, you
can easily set up a task to start when its predecessor is halfway finished. After
entering task dependencies, the software should easily show you the critical path
and slack for each task. You can also set up multiple projects in a program and
perform portfolio management analysis with some products. Many project
management software products also allow you to easily adjust resources within
their slack allowances to create a smoother resource distribution. These advanced
features unique to project management are rarely found in other software tools.

As you can see, there are several important features that are unique to project
management software that make them worth using. Next you’ll learn how to use basic
features of Project 2007 Standard.

USING PROJECT 2007
Before you can use Project 2007 or any project management software effectively,

you must understand the fundamental concepts of project management, such as creating
work breakdown structures, linking tasks, entering duration estimates, assigning
resources, and so on. Make sure you read most of this text before using Project 2007 so
you understand these concepts. Note that Project 2007 uses an interface similar to Office
2003. Project 2010, due for release in spring 2010, includes the newer ribbon-interface
first introduced with Office 2007. This text provides instructions for using the stand-
alone version of Project 2007known as Project Standard. Project Professional and the
Enterprise version of Project require special server software to perform online and
collaborative functions. Consult Microsoft’s Web site for detailed information on other
products.

Before You Begin
This appendix assumes you are using Project 2007 with Windows XP, Vista, or Windows
7 and are familiar with other Windows-based applications. You can download a free trial
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from Microsoft’s Web site at www.microsoft.com/project. Check your work by
reviewing the many screen shots included in the steps, or by using the solution files that
are available for download from the companion Web site for this text or from your
instructor.

NOTE: You need to be running Windows XP, Vista, or Windows 7 to use Project 2007. It
does not run on Macintosh computers or other operating systems. Most organizations
have Project 2007 as part of their license if they have Office 2007. A new version of
Project will be available in spring 2010. Students can purchase a full version of Project
Standard from sites like www.journeyed.com for around $69. Check the companion Web
site for further information.

This appendix uses a fictitious project—Project A+—to illustrate how to use the
software. The WBS for Project A+ uses the five project management process groups as
level 2 items (initiating, planning, executing, monitoring and controlling, and closing).
Standard deliverables under each of those process groups are included, as described in
this text. Each section of the appendix includes hands-on activities for you to perform.

NOTE: To complete the hands-on activities in the appendix, you will need to download
files from the companion Web site for this text (http://groups.google.com/group/intropm)
to your computer. You can also download the files from the author’s Web site
(www.kathyschwalbe.com) under Book FAQs. When you begin each set of steps, make
sure you are using the correct file. Before you begin your work you should have
Customer Feedback.mpp file. Save the files you create yourself in a different folder so
you do not write over the ones you download.

In addition, you will create the following files from scratch as you work through
the steps:

 wbs.mpp

 schedule.mpp

You will also use the following file to create a hyperlink:

 stakeholder_register.doc

Next you will learn how to start Project 2007, review the Help facility and a
template file, and begin to plan Project A+.

Overview of Project 2007
The first step to mastering Project 2007 is to become familiar with the Help facility,
online tutorials, major screen elements, views, and filters. This section describes each of
these features.

www.microsoft.com/project
www.journeyed.com
http://groups.google.com/group/intropm
www.kathyschwalbe.com
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Starting Project 2007 and Understanding the Main Screen
Elements
To start Project 2007:

1. Open Project 2007. Click the Start button on the taskbar, point to All
Programs in Windows XP or Programs in Vista, point to Microsoft Office,
and then click Microsoft Office Project 2007. Alternatively, a shortcut or
icon might be available on the desktop; in this case, double-click the icon to
start the software.

2. Maximize Project 2007. If the Project 2007 window does not fill the entire
screen as shown in Figure A-3, click the Maximize button in the upper-right
corner of the window.

Tasks pane       Indicator column   Entry table   Gantt chart view

Figure A-3. Project 2007 main screen

Menu bar
Toolbar

View bar

Entry bar

Split bar
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HELP: If the View Bar is not open, click View on the Menu bar, and then click View
Bar. If the Tasks pane is not open, click View on the Menu bar, and then click Turn On
Project Guide. Also, your toolbars, date formats, or other screen elements may look
slightly different from Figure A-3.

Project 2007 is now running and ready to use. Look at some of the elements of
the Project 2007 screen.

 The Menu bar and Toolbar are similar to other Office 2003 applications.

 When you start Project 2007, the Project Guide Tasks pane automatically
opens. The Project Guide can help you learn Project 2007 by providing
instructions for completing various steps in building a Project 2007 file.
For this brief guide, you will not be using the Project Guide. To close it,
simply click on the Close icon (the X in the upper right of the Project
Guide window).

 The default view is the Gantt Chart view, which shows tasks and other
information as well as a calendar display.

 The areas where you enter information in a spreadsheet-like table are
part of the Entry table. For example, you can see entry areas for Task
Name, Duration, and Start date.

 You can make the Entry table more or less wide by using the Split bar.
When you move the mouse over the split bar, your cursor changes to the
resize pointer. Clicking and dragging the split bar to the right reveals
other task information in the Entry table, including Finish date,
Predecessors, and Resource Names columns.

 You can see what you enter in a particular cell in the Entry bar.

 The column to the left of the Task Name column in the Entry table is the
Indicators column. The Indicators column displays indicators or symbols
related to items associated with each task, such as task notes or
hyperlinks to other files.

 You can access other views by clicking each button in the View Bar on
the left side of the screen.

Notice that when Project 2007 starts, it opens a new file named Project1, as
shown in the title bar. If you open a second file, the name will be Project2, and so on,
until you save and rename the file.

You can access information to help you learn how to use Project 2007 under the
Help menu. Figure A-4 shows the detailed list of topics available from the first Help
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option, Microsoft Office Project Help. You can also access this same menu by Pressing
F1 or clicking on the question mark/help icon on the toolbar.

Figure A-4. Topics under Microsoft Office Project help

Microsoft provides a number of resources on its Web site to help you learn how
to use Project 2007. They provide product information, help and how-to guides on
various versions of Project, training information, and templates. Microsoft’s Web site for
Project 2007 (www.microsoft.com/project) provides files for users to download, case
studies, articles, and other useful materials. Figure A-5 shows a screen shot of this Web
site from June 2009. See the companion Web site for this text for updated information on
Project and other resources.

www.microsoft.com/project
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Figure A-5. Microsoft Office Project web site (www.microsoft.com/project)

Adjusting Main Screen Elements
The Project 2007 default main screen is called the Gantt Chart view. At the top of the
main screen, the Menu bar and Standard toolbar are similar to those in Windows 2003
programs. Project 2007 does not have the new ribbons found in other Office 2007
applications. The order and appearance of buttons on the Standard toolbar may vary,
depending on the features you are using and how the Standard toolbar is customized.
When you use a button, it automatically becomes visible on the toolbar it is associated
with. You can display the Standard toolbar in one row or two, or you can set it to always
show full menus so that all buttons are visible all the time. Additional toolbars in Project
2007 include the Formatting toolbar, the Custom Forms toolbar, and the Tracking
toolbar, among others.

You can also add or remove buttons in the toolbars in Project 2007 just as you
would in Office 2003 programs. Simply click on the Toolbar Options icon, as shown in
Figure A-6, and select the icons you wish to add or remove, such as the Zoom In and
Zoom Out icons (magnifying glasses with a plus and minus sign on them) highlighted in
the figure.

www.microsoft.com/project
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Add or Remove Buttons        Zoom In/Zoom Out

Task Notes

Toolbar Options

Figure A-6. Adding buttons to the toolbar

Many features in Project 2007 are similar to ones in other Windows programs.
For example, to collapse or expand tasks, click the appropriate symbols to the left of the
task name. To access shortcut items, right-click in either the Entry table area or the Gantt
chart. Many of the Entry table operations in Project 2007 are very similar to operations in
Excel. For example, to adjust a column width, click and drag or double-click between the
column heading titles.

If you select another view and want to return to the Gantt Chart view, click the
Gantt Chart button on the View Bar on the left of the screen, or select View from the
Menu bar, and click Gantt Chart. If the Entry table appears to be different, select View
from the Menu bar, point to Table: Entry, and then click Entry to return to the default
Entry Table view. If the View Bar does not display, select View Bar from the View
menu.

Next, you will get some hands-on experience by opening an existing file to
explore various screen elements. Project 2007 comes with several template files, and you
can also access templates from Microsoft Office Online or other Web sites.

Note: You normally open template files on your computer by clicking File on the
Menu bar, and then clicking New. In the New Project task pane, you then click the On
computer option under Templates. To make sure you have the proper file for the
following steps, you will download it from the companion Web site and simply open it.
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EXPLORING PROJECT 2007 USING AN EXISTING
FILE
To open a file and adjust Project 2007 screen elements:

1. Open an existing file. Click the Open button on the Standard toolbar, browse
to find the file named Customer Feedback.mpp that you copied from the
companion Web site for this text or the author's Web site, and then double-click
the filename to open the file. This file is a template file that comes with Project
2007 where it is called Customer Feedback Monitoring. Your screen should
resemble Figure A-7.

View Bar        Tasks Pane       Entry Table              Gantt Chart

Figure A-7. Customer Feedback.mpp file

2. Close the Tasks pane: Click the Close button to close the Task pane window
so you can see more of the file on your screen. Move your mouse over the top
symbol on the Gantt chart, a long gray bar. Notice that this project was fairly
short in length, only 19 work days, starting on January 1, 2007.

3. View the Note. Move your mouse over the yellow Notes icon in the
Indicators column for Task 2and read its contents. It is a good idea to provide a
short note describing the purpose of project files. (You simply click the Tasks
Notes button on the toolbar to add a note.)

4. Adjust the timescale. Click the Zoom Out button (the magnifying glass with
the plus sign) on the toolbar once to display the timescale in days instead of
weeks. Click the Zoom In button (the magnifying glass with the minus sign)
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once to change the timescale back to weeks. Each time you click the Zoom Out
or Zoom In icon, the timescale gets more or less detailed. If you cannot find the
Zoom Out button, you can add it to the Standard toolbar by clicking the Toolbar
Options button, as described earlier. The first line in the Entry bar for this file
displays the filename, and the bar in the Gantt chart next to that line shows the
timeline for the entire project.

5. Select Outline Level 1 to display WBS level 2 tasks. On the Standard toolbar,
click the Show button’s list arrow, and then click Outline Level 1, as shown in
Figure A-8. Notice that only the level 2 WBS items display in the Entry table
after you select Outline Level 1, and the timescale shows weeks. The black bars
on the Gantt chart represent the summary tasks. Recall that the entire project is
normally referred to as WBS level 1, and the next highest level is called level 2.
This view of the file also shows one milestone task in row 43 indicating when the
project was completed. Recall that the black diamond symbol on a Gantt chart
shows milestones.

Figure A-8. Viewing summary tasks using the show button

6. Move the split bar to reveal more Entry table columns. Move the split bar to
the right to reveal the Resource Names column.

7. Adjust the Task Name column width. Move the cursor over the right-column
gridline in the Task Name column heading until you see the resize pointer, and
then double-click the left mouse button to resize the column width automatically.

8. Expand a task. Click the expand symbol (the plus sign) to the left of Task 2,
Develop Customer Feedback Collection Processes, to see its subtasks. Your
screen should resemble Figure A-9. Click the collapse symbol (the minus sign)
to hide its subtasks. Experiment with expanding and collapsing other tasks and
resizing other columns.

Show
button

Split bar

Expand
symbol
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Figure A-9. Adjusting screen elements

9. Close the file without saving. Click the Close icon and select No when
prompted to save the file.

Project 2007 Views
Project 2007 provides many ways to display or view project information. To the left of
the Entry table is the View Bar. Instead of using commands on the View menu to change
views, you can click buttons on the View Bar. Several views discussed in the main text
are on the default View Bar, such as the Gantt Chart, Network Diagram, Tracking Gantt,
and Resource Graph (a resource histogram for an individual). These views allow you to
analyze project information in different ways. The View menu also provides access to
different tables that display information in various ways. In addition to the default Entry
table view, you can access tables that focus on data related to the Schedule, Cost,
Tracking, and Earned Value.

To access and explore different views:

1. Explore the Network Diagram view in the Customer Feedback file. Open
the Customer Feedback file again and close the Task pane. Click the Network
Diagram button on the View Bar, and then click the Zoom Out button
(magnifying glass with the minus sign) on the toolbar twice. Your screen should
resemble Figure A-10.
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Figure A-10. Network diagram view of customer feedback file

2. Explore the Calendar view. Click the Calendar button on the View Bar (the
first icon). Notice that the screen lists tasks each day in a tabular calendar format.

3. Examine columns in the Entry table. Click the Gantt Chart button on the
View Bar, move the split bar to the right to see all of the available columns, and
review the information provided in each column of the Entry table.

4. Examine the Table: Schedule and other views. Click View on the Menu bar,
move your mouse to Table: Entry, and then click Schedule in the cascading
menu to the right. Figure A-11 shows these menu items. Notice that the columns
now display more detailed schedule information, such as Start date, Finish date,
Late Start, Total Slack, etc. Also notice that all of the text in the Task Name
column is not visible. Remember that you can widen the column by double-
clicking the resize pointer to the right of that column. You can also move the split
bar to the right to reveal more columns. Experiment with other table views, then
return to the Table: Entry view.

Network
diagram
view
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Figure A-11. Schedule table view

5. Explore the Reports feature. Click Report on the Menu bar, and then click
Reports. The Reports dialog box displays, as shown in Figure A-12.

Figure A-12. Reports dialog box

6. View the Project Summary report. Double-click Overview from the Reports
dialog box, and then double-click Project Summary in the Overview Reports
dialog box. Notice that the insertion point now resembles a magnifying glass.
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Click inside the report to zoom in or zoom out. Click the Close button to close
this report, and then experiment with viewing other reports. You will use several
reports and other views later in this appendix.

7. Close the Reports feature. Click Close to close the Reports dialog box and
return to the Gantt Chart view.

Project 2007 Filters
Project 2007 uses a relational database to filter, sort, store, and display information.
Filtering project information is very useful. For example, if a project includes thousands
of tasks, you might want to view only summary or milestone tasks to get a high-level
view of the project by using the Milestones or Summary Tasks filter from the Filter list.
You can select a filter that shows only tasks on the critical path if that is what you want to
see. Other filters include Completed Tasks, Late/Overbudget Tasks, and Date Range,
which displays tasks based on dates you provide. As shown earlier, you can also click the
Show button on the toolbar to display different levels in the WBS quickly.

To explore Project 2007 filters:

1. Apply a filter to see only milestone tasks. From the Table: Entry view in the
Customer Feedback file, click the Filter list arrow, as shown in Figure A-13.
The default filter is All Tasks. If the Filter list arrow is not showing on your
toolbar, you may need to add it by selecting the Toolbar Options button on the
toolbar, as described earlier.

Figure A-13. Using a filter

2. Filter to show specific tasks. Click Milestones in the list of filters, and move
the split bar if needed to see all the milestones on the Gantt chart. Your screen
should resemble Figure A-14. Recall that a black diamond symbol represents a
milestone, a significant event on a project.

Filter list arrow
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Figure A-14. Milestone tasks filter applied

3. Show summary tasks. Select All Tasks from the Filter list box to reveal all
the tasks in the WBS again. Click the Filter list arrow, scroll down until you see
Summary Tasks, and then click Summary Tasks. Now only the summary tasks
appear in the WBS. Experiment with other outline levels and filters.

4. Close the file. When you are finished reviewing the Customer Feedback file,
click Close from the File menu or click the Close button. Click No when asked if
you want to save changes.

5. Exit Project 2007. Select Exit from the File menu or click the Close button
for Project 2007.

Now that you are familiar with the Project 2007 main screen elements, views,
and filters, you will learn how to use Project 2007 to create a new file.

CREATING A NEW FILE AND ENTERING TASKS IN
A WORK BREAKDOWN STRUCTURE
To create a new Project 2007 file, you must first name the project, enter the start date,
and then enter the tasks. The list of tasks and their hierarchy is the work breakdown
structure (WBS). The file you create could be used for a class project which lasts
approximately three months. It uses the project management process groups to organize
tasks and includes several deliverables described in this text. You could also modify this
file to meet your specific needs.

Milestone
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NOTE: In this section, you will go through several steps to create a new Project 2007 file
named wbs.mpp. If you want to download the completed file to check your work or
continue to the next section, a copy of wbs.mpp is available on the companion Web site
for this text, from the author’s Web site, or from your instructor. Try to complete an
entire section of this appendix (entering tasks in a work breakdown structure, developing
the schedule, and so on) in one sitting to create the complete file.

Creating a New Project File
To create a new project file:

1. Create a blank project. Open Project 2007, and close the Project Guide Tasks
pane. A blank project file automatically opens when you start Project 2007. The
default filenames are Project1, Project2, and so on. (If Project 2007 is already
open and you want to open a new file, click the New button on the toolbar or
select File and then New from the Menu bar and select a Blank Project.)

2. Open the Project Information dialog box. Click Project on the Menu bar, and
then click Project Information to display the Project Information dialog box, as
shown in Figure A-15. This dialog box enables you to set dates for the project,
select the calendar to use, and view project statistics. The project start date will
default to the current date. Note that in Figure A-15 the file was created on
6/12/09 and a Start date of 2/1/10 was entered.

NOTE: All dates are entered in month/day/year or American format. You can change the
date format by selecting Tools from the Menu bar, clicking Options, and then selecting
the View tab. Click the date format you want to use in the Date Format box.
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Figure A-15. Project information dialog box

3. Enter the project start date. In the Start date text box, enter 2/01/10. Setting
your project start date to 2/01/10 will ensure that your work matches the results
that appear in this appendix. Leave the Finish date, Current date, and other
information at the default settings. Click OK or press Enter.

4. Enter project properties. Click File on the Menu bar, and then click
Properties. Type Project A+ in the Title text box, type Your Name in the Author
text box, as shown in Figure A-16, and then click OK. You may have some
default information entered in the Project Properties dialog box, such as your
company’s name. Keep this file open for the next set of steps.

Start
date
text box

Current
date
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Figure A-16. Project properties dialog box

Creating a Work Breakdown Structure Hierarchy
As mentioned in Chapter 4 of this text, a work breakdown structure (WBS) is a
fundamental part of project management. Developing a good WBS takes time, and it will
make entering tasks into the Entry table easier if you develop the WBS first. For this
example, you will use the project management process groups and some key processes
and deliverables to create the WBS. You will use the information in Table A-2 to enter
tasks.
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To develop a WBS for the project:

1. Enter task names. Enter the 30 tasks in Figure A-17 into the Task Name
column in the order shown. Do not worry about durations or any other
information at this time. Type the name of each task into the Task Name column
of the Entry table, beginning with the first row. Press Enter or the down arrow
key on your keyboard to move to the next row.

1. Initiating 16. Work on deliverable 2

2. Identify stakeholders 17. Work on deliverable 3

3. Stakeholder register completed 18. Deliverable 1 completed

4. Stakeholder management strategy
completed

19. Deliverable 2 completed

5. Prepare project charter 20. Deliverable 3 completed

6. Project charter completed 21. Monitoring and Controlling

7. Prepare for kickoff meeting 22. Track actual hours

8. Kickoff meeting completed 23. Update project documents

9. Planning 24. Progress report 1

10. Prepare draft schedule 25. Progress report 2

11. Gantt chart completed 26. Hold meetings

12. Prepare scope statement 27. Closing

13. Initial scope statement completed 28. Prepare final project report

14. Executing 29. Prepare final presentation

15. Work on deliverable 1 30. Project completed

Figure A-17. Task list for Project A+
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HELP: If you accidentally skip a task, highlight the task row and select Insert from the
Menu bar, and then select New Task to insert a blank row (or right-click and insert the
new task). To edit a task entry, click the text for that task, click the Entry bar under the
Formatting toolbar, and either type over the old text or edit the existing text.

TIP: Entering tasks into Project 2007 and editing the information is similar to entering
and editing data in an Excel spreadsheet. Project 2007, like earlier versions, includes a
feature called a SmartTag, which appears, for example, when you delete a row. The
SmartTag clarifies whether you want to delete the entire task or only clear the contents of
a cell. You can also easily copy and paste text from Excel or Word into Project, such as
the list of tasks.

2. Adjust the Task Name column width as needed. To make all the text display
in the Task Name column, move the mouse over the right-column gridline in the
Task Name column heading until you see the resize pointer , and then click the
left mouse button and drag the line to the right to make the column wider, or
double-click to adjust the column width automatically.

This WBS separates tasks according to the project management process groups
of initiating, planning, executing, controlling, and closing. These tasks will be the level 2
items in the WBS for this project. (Remember the whole project is level 1.) It is a good
idea to include all of these process groups because there are important tasks that must be
done under each of them. Recall that the WBS should include all of the work required for
the project. In the Project A+ WBS, the tasks will be purposefully left at a high WBS
level (level 3). You will create these levels, or the WBS hierarchy, next when you create
summary tasks. For a real project, you would usually break the WBS into even more
levels to provide more details to describe all the work involved in the project. For
example, each deliverable would probably have several levels and tasks under it.

Creating Summary Tasks
After entering the WBS tasks listed in Figure A-17 into the Entry table, the next step is to
show the WBS levels by creating summary tasks. The summary tasks in this example are
Tasks 1 (initiating), 9 (planning), 14 (executing), 21 (monitoring and controlling), and 27
(closing). You create summary tasks by highlighting and indenting their respective
subtasks.

To create the summary tasks:

1. Select lower level or subtasks. Highlight Tasks 2 through 8 by clicking the
cell for Task 2 and dragging the mouse through the cells to Task 8.

2. Indent subtasks. Click the Indent button on the Formatting toolbar (or press
Alt + Shift + right arrow) so your screen resembles Figure A-18. After the
subtasks (Tasks 2 through 8) are indented, notice that Task 1 automatically
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becomes boldface, which indicates that it is a summary task. A collapse symbol
appears to the left of the new summary task name. Clicking the collapse symbol
(minus sign) will collapse the summary task and hide the subtasks beneath it.
When subtasks are hidden, an expand symbol (plus sign) appears to the left of the
summary task name. Clicking the expand symbol will expand the summary task.
Also, notice that the symbol for the summary task on the Gantt chart has changed
from a blue to a black line with arrows indicating the start and end dates.

Expand or collapse symbols by
Summary tasks Indent Summary task symbol

Figure A-18. Indenting tasks to create the WBS hierarchy

3. Create other summary tasks and subtasks. Create subtasks and summary
tasks for the other process groups by following the same steps. Indent Tasks 10
through 13 to make Task 9 a summary task. Indent Tasks 15 through 20 to make
Task 14 a summary task. Indent Tasks 22 through 26 to make Task 21 a summary
task. Indent Tasks 28 through 30 to make Task 27 a summary task. Widen the
Task Name column to see all of your text, as needed.

TIP: To change a task from a subtask to a summary task or to change its level in the
WBS, you can “outdent” the task. To outdent the task, click the cell of the task or tasks
you want to change, and then click the Outdent button on the Formatting toolbar (the
button just to the left of the Indent button). You can also press Alt + Shift + Right Arrow
to indent and Alt + Shift + Left Arrow to outdent.

Numbering Tasks
To display automatic numbering of tasks using the standard tabular numbering system for
a WBS:

1. Display the Options dialog box. Click Tools on the Menu bar, and then click
Options. The Options dialog box opens.

2. Show outline numbers. Click the View tab, if necessary. Check Show outline
number in the “Outline options for Project1” section of the View tab. Click OK
to close the dialog box. Figure A-19 shows the Options dialog box and resulting
outline numbers applied to the WBS tasks.
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Outline numbers Show outline number check box

Figure A-19. Adding automatic outline numbers

Saving Project Files Without a Baseline
An important part of project management is tracking performance against a baseline, or
approved plan. It is important to wait until you are ready to save your file with a baseline
because Project 2007 will show changes against a baseline. Since you are still developing
your project file for the Project A+ project, you want to save the file without a baseline.
The default in Project 2007 is to save without a baseline. Later in this appendix, you will
save the file with a baseline by selecting Tools, Tracking, and then Set Baseline. You will
then enter actual information to compare planned and actual performance data.

To save a file without a baseline:

1. Save your file. Click File on the Menu bar and then click Save, or click the
Save button on the Standard toolbar.

2. Enter a filename. In the Save As dialog box, type wbs in the File name text
box. Browse to the location in which you want to save the file, and then click
Save. Your Project 2007 file should look like Figure A-20. (Remember that you
can adjust the timescale by clicking Zoom In or Zoom Out.)

HELP: If you want to download the Project 2007 file wbs.mpp to check your work or
continue to the next section, a copy is available on the companion Web site for this text,
the author’s Web site, or from your instructor.
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Figure A-20. Project 2007 WBS file
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DEVELOPING THE SCHEDULE
Many people use Project 2007 for its scheduling features. The first step in using these
features, after inputting the WBS for the project, is to change calendars, if needed, and
then enter durations for tasks or specific dates when tasks will occur. You must also enter
task dependencies in order for schedules to adjust automatically and to do critical path
analysis. After entering durations and task dependencies, you can view the network
diagram, critical path, and slack information.

Calendars
The standard Project 2007 calendar assumes that working hours are Monday through
Friday, from 8:00 a.m. to 5:00 p.m., with an hour for lunch from noon until 1:00 p.m.
You can create a different calendar to meet your unique project requirements.

To create a new base calendar using the Tasks pane:

1. Open a new file. With Project 2007 open, click the New button on the
Standard toolbar to open a new Project 2007 file. The Tasks pane opens on the
left side of your screen.

2. Use the Tasks pane to create a new calendar. Click Define general
working times in the Tasks pane. (If the Tasks pane does not appear on your
screen, click View on the Menu bar, and then click Turn On Project Guide to see
the Project Guide Task pane). A calendar wizard appears, as shown in Figure A-
21.

Figure A-21. Changing working time with the tasks pane

2. Make changes to the calendar using the wizard. Click Continue to
Step 2 at the lower part of the Project Working Times pane, select the check box
for Friday to make it a non-working day, and then click the I want to adjust
the working hours shown for one or more days of the week radio button.
Scroll down to read the instructions for adjusting working hours, and make
changes as desired. Click through the remaining steps to close the wizard.
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To create a new base calendar using the Tools menu:

1. Access the Change Working Time dialog box. Click Tools on the Menu
bar, and then click Change Working Time. The Change Working Time dialog
box opens.

2. Name the new base calendar. In the Change Working Time dialog box,
click Create New Calendar. The Create New Base Calendar dialog box
opens. Click the Create new base calendar radio button, type Project A+ as
the name of the new calendar in the Name text box, and then click OK. Click
OK to close the Change Working Time dialog box.

You can use this new calendar for the whole project, or you can assign it to
specific resources on the project.

To assign the new calendar to the whole project:

1. Open the Project Information dialog box. Click Project on the Menu
bar, and then click Project Information. The Project Information dialog box
opens.

2. Select a new calendar. Click the Calendar list arrow to display a list of
available calendars. Select your new calendar named Project A+ from this list,
and then click OK.

To assign a specific calendar to a specific resource:

1. Assign a new calendar. Click View on the Menu bar, and then click
Resource Sheet. Type Adam in the Resource Name column, press Enter, and
then select the word Adam.

2. Select the calendar. Click the Base Calendar cell on the right part of the
screen for Adam. If the Base Calendar column is not visible, click the horizontal
scroll bar to view more columns. Click the Base Calendar list arrow to display
the options, and then select Project A+, as shown in Figure A-22.

Figure A-22. Changing calendars for specific resources

3. Block off vacation time. Double-click the resource name Adam to display
the Resource Information dialog box, and then click the Change Working
Time button, located on the General tab in the Resource Information dialog box.
You can block off vacation time for people by selecting the appropriate days on
the calendar and marking them as nonworking days. Click OK to accept your
changes, and then click OK to close the Resource Information dialog box.
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4. Close the file without saving it. Click File on the Menu bar, and then click
Close. Click No when you are prompted to save the file.

Entering Task Durations
You probably noticed that when you enter a task, Project 2007 automatically assigns it a
duration of one day, followed by a question mark. To change this default duration, type a
task’s estimated duration in the Duration column or use the scroll box to select the
duration. If you are unsure of an estimate and want to review it again later, enter a
question mark after it. For example, you could enter 8d? for a task with an estimated
duration of eight days that you want to review later. You can then use the Tasks With
Estimated Durations filter to see quickly the tasks for which you need to review duration
estimates.

To indicate the length of a task’s duration, you normally type both a number and
an appropriate duration symbol. If you type only a number, Project 2007 automatically
enters days as the duration unit. Duration unit symbols include:

 d = days (default)

 w = weeks

 m = minutes

 h = hours

 mo or mon = months

 ed = elapsed days

 ew = elapsed weeks

For example, to enter two weeks for a task duration, type 2w in the Duration
column. (You can also type wk, wks, week, or weeks, instead of just w.) To enter four
days for a task’s duration, type 4 or 4d in the Duration column. You can also enter
elapsed times in the Duration column. For example, 3ed means three elapsed days, and
2ew means two elapsed weeks.

You would use an elapsed duration for a task like “Allow cement to dry.” The
cement will dry in exactly the same amount of time regardless of whether it is a workday,
a weekend, or a holiday. Project’s default calendar does not assume that work is done on
weekends. You will learn to change the calendar later in this appendix.

It is important to follow a few important rules when entering durations:

 Do not enter durations for summary tasks. Summary task durations are
calculated automatically based on the subtasks. Project 2007 will not allow
you to enter or change the duration of a summary task. Remember that you
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only enter durations for work packages, the lowest-level items in your WBS.
The other items are just the WBS hierarchy.

 To mark a task as a milestone, enter 0 for the duration. You can also mark
tasks that have a non-zero duration as milestones by checking the “Mark task
as milestone” option in the Task Information dialog box on the Advanced tab.
The milestone symbol for those tasks will appear at their start date.

 You can enter the exact start and finish dates for activities instead of entering
durations. To enter start and finish dates, move the split bar to the right to
reveal the Start and Finish columns. Enter start and finish dates only when
those dates are certain.

 If you want task dates to adjust according to any other task dates, do not
enter exact start and finish dates. Instead, enter durations and then establish
dependencies to related tasks.

 To enter recurring tasks, such as weekly meetings, select Recurring Task
from the Insert menu. Enter the task name, the duration, and when the task
occurs. Project 2007 will automatically insert appropriate subtasks based on
the length of the project and the number of tasks required for the recurring
task.

 Project 2007 uses a default calendar with standard workdays and hours.
Remember to change the default calendar if needed, as shown earlier.

Next, you will set task durations in the Project A+ file that you created and saved
in the previous section. If you did not create the file named wbs.mpp, you can download
it from the companion Web site for this text.

Use the information in Figure A-23 to enter durations. The Project 2007 row
number is shown to the left of each task name in the table.
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Task Row Task Name Duration

3 Stakeholder register completed 0

4 Stakeholder management strategy completed 0

5 Prepare project charter 1w

6 Project charter completed 0

7 Prepare for kickoff meeting 3d

8 Kickoff meeting completed 0

10 Prepare draft schedule 5d

11 Gantt chart completed 0

12 Prepare scope statement 8d

13 Initial scope statement completed 0

15 Work on deliverable 1 3w

16 Work on deliverable 2 5w

17 Work on deliverable 3 6w

18 Deliverable 1 completed 0

19 Deliverable 2 completed 0

20 Deliverable 3 completed 0

24 Progress report 1 0

25 Progress report 2 0

28 Prepare final project report 4d

29 Prepare final presentation 4d

30 Project completed 0

Figure A-23. Task durations for Project A+

2 Identify stakeholders                                            3d



33

Entering Task Durations
To enter task durations for the non-summary tasks:

1. Enter the duration for Task 2. Using the wbs file, click the Duration column

duration for the first task, Initiating, also changed since it is a summary task.

2. Enter the duration for Task 3. In the Duration column for row 3, Stakeholder
register completed, type 0, then press Enter. Remember that a task with zero
duration is a milestone. Notice the milestone or black diamond symbol that
appears on the Gantt chart.

3. Enter remaining task durations. Continue to enter the durations using the
information in Figure A-23. Do not enter durations for tasks not listed in the
figure.

4. Insert a recurring task above Task 26, Hold meetings. Click Hold meetings
(Task 26) in the Task Name column to select that task. Click Insert on the Menu
bar, and then click Recurring Task. The Recurring Task Information dialog box
opens.

5. Enter task and duration information for the recurring task. Type Hold
meetings as the task title in the Task Name text box. Type 30min in the Duration
text box. Select the Weekly radio button under Recurrence pattern. Make sure
that 1 is entered in the Recur every list box. Select the Thursday check box. In
the Range of recurrence section, type 2/1/10 in the Start text box, click the End
by radio button, and then type 4/29/10 in the End by text box, as shown in Figure
A-24. The new recurring task will appear above Task 26, Hold meetings, when
you are finished. Delete task 40, Hold meetings, by right clicking on row 40 and
selecting Delete Task.

TIP: You can also enter a number of occurrences instead of an End by date for a
recurring task. You might need to adjust the End by date after you enter all of your task
durations and dependencies. Remember, the date on your computer determines the date
listed as Today in the calendar.

for row 2, Identify stakeholders, type 3d , and then press Enter. Notice that the
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Figure A-24. Recurring task information dialog box

6. View the new summary task and its subtasks. Click OK. Project 2007 inserts
a new Hold meetings subtask in the Task Name column. Expand the new subtask
by clicking the expand symbol to the left of Hold meetings. To collapse the
recurring task, click the collapse symbol. Move your mouse over the Recurring
Task symbol in the Indicator column for row 26. Notice that the recurring task
appears on the appropriate dates on the Gantt chart.

7. Adjust the timescale. Click the Zoom Out button to display months in the
Gantt chart. Move the split bar so that only the Task Name and Duration
columns are visible. If needed, increase the Duration column’s width so all of the
text is visible.

8. Save your file and name it. Click File on the Menu bar, and then click Save
As. Enter schedule as the filename, and then save the file to the desired location
on your computer or network. Notice that all of the tasks still begin on February
1. This will change when you add task dependencies. Keep this file open for the
next set of steps.

Establishing Task Dependencies
To use Project 2007 to adjust schedules automatically and perform critical path analysis,
you must determine the dependencies or relationships among tasks. There are several
different methods for creating task dependencies: using the Link Tasks button, using the
Predecessors column of the Entry table or the Predecessors tab in the Task Information
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dialog box, or clicking and dragging the Gantt chart symbols for tasks with dependencies.
You will use the first two methods in the following steps.

To create dependencies using the Link Tasks button, highlight tasks that are
related and then click the Link Tasks button on the toolbar. For example, to create a
finish-to-start dependency between Task 1 and Task 2, click any cell in row 1, drag down
to row 2, and then click the Link Tasks button. The default type of link is finish-to-start.
In the Project A+ file, you will also set up some other types of dependencies and use the
lag option to set up overlaps between dependent tasks.

TIP: To select adjacent tasks, click and drag the mouse to highlight them. You can also
click the first task, hold down the Shift key, and then click the last task. To select
nonadjacent tasks, hold down the Control (Ctrl) key as you click tasks in order of their
dependencies.

When you use the Predecessors column of the Entry table to create dependencies,
you must manually enter the information. To create dependencies manually, type the task
row number of the preceding task in the Predecessors column of the Entry table. For
example, Task 3 has Task 2 as a predecessor, which can be entered in the Predecessors
column, meaning that Task 3 cannot start until Task 2 is finished. To see the Predecessors
column of the Entry table, move the split bar to the right. You can also double-click on
the task, click the Predecessors tab in the Task Information dialog box, and enter the
predecessors there.

Next, you will use information from Figure A-25 to enter the predecessors for
tasks as indicated. You will create some dependencies by manually typing the
predecessors in the Predecessors column, some by using the Link Tasks button, and the
remaining dependencies by using whichever method you prefer.

To link tasks or establish dependencies for Project A+:

1. Display the Predecessors column in the Entry table. Move the split bar to the
right to reveal the full Predecessors column in the schedule.mpp file you saved in
the previous section. Widen the Task Name or other columns, if needed.

2. Highlight the cell where you want to enter a predecessor, and then type the
task number for its predecessor task. Click the Predecessors cell for Task 3,
Stakeholder register completed, type 2, and press Enter. Notice that as you enter
task dependencies, the Gantt chart changes to reflect the new schedule. Also
notice that several cells become highlighted. In this case, the Duration and Finish
cells for Task 1, and the Start and Finish cells for Task 3, are highlighted in light
blue, showing the Visual Change Highlights feature of Project 2007.

3. Enter predecessors for Task 4. Click the Predecessors cell for Task 4, type 2,
and press Enter.

4. Establish dependencies using the Link Tasks button. To link Tasks 5 and 6,
click the task name for Task 5 in the Task Name column and drag down through
Task 6. Then, click the Link Tasks button on the toolbar. Alternately, you can
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click Edit on the Menu bar, and then click Link Tasks. Notice that the result is
the same as typing 5 in the Predecessors column for Task 6.

5. Enter dependencies and lag time using the Task Information dialog box.
Double-click on the Task Name for task 5, Prepare project charter, and then
click on the Predecessors tab in the Task Information dialog box. Click in the
cell under Task Name, then click the down arrow and select Identify
stakeholders. Click in the cell under Type to see the various types of
dependencies. For this task, you will keep the default type of finish-to-start.
Click in the cell under Lag, then type -50% and press Enter. (Lag means there
is a gap between tasks, and lead or negative lag means there is an overlap). Your
screen should resemble Figure A-25. Click OK to close the dialog box. Notice
that the Predecessor column for task 5 displays 2FS-50%, meaning there is a
finish-to-start relationship with task 2 and a lag of -50%, meaning the task can
start when task 2 is 50% completed.

Figure A-25. Entering predecessor information using the task information
dialog box

6. Enter remaining dependencies. Link the other tasks by either manually
entering the predecessors into the Predecessors column, by using the Link Tasks
button, or using the Task Information dialog box. Use the information in Figure
A-26 to make your entries. If you have entered all data correctly, the project
should end on 4/29, or April 29, 2010. (Note that you could manually enter a
Start date for tasks 22 and 23 to make those dates more realistic. The current
dependency shows them both ending one day before the project ends.)
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Task Row Task Name Predecessors

3 Stakeholder register completed 2

4 Stakeholder management
strategy completed

2

5 Prepare project charter 2FS-50%

6 Project charter completed 5

7 Prepare for kickoff meeting 2,6

8 Kickoff meeting completed 7,6

10 Prepare draft schedule 5,12FS-50%

11 Gantt chart completed 10

12 Prepare scope statement 5

13 Initial scope statement
completed

12

15 Work on deliverable 1 12

16 Work on deliverable 2 18

17 Work on deliverable 3 18

18 Deliverable 1 completed 15

19 Deliverable 2 completed 16

20 Deliverable 3 completed 17

22 Track actual hours 43FF-1 day,2

23 Update project documents 43FF-1 day,3

41 Prepare final project report 18,19,20

42 Prepare final presentation 18,19,20

43 Project completed 41,42

Figure A-26. Predecessor information for Project A+
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7. Add the project summary task. Click Tools from the Menu bar, and select
Options. Click on the View tab if needed, then check the Show project
summary task checkbox, and then click OK. Project adds a new row, row 0,
and enters the name of the project in the Task Name column. It also makes this
new task a summary task for the whole project. If needed, click the Zoom Out
button to view the Gantt chart timescale in months. When you finish, your screen
should resemble Figure A-27.Double-check your screen to make sure you entered
the dependencies correctly.

Figure A-27. Project A+ file with durations and dependencies entered

8. Preview and save your file. Click File on the Menu bar, and then select Print
Preview, or click the Print Preview button on the Standard toolbar. When you
are finished, close the Print Preview and save your file again by clicking the Save
button on the Standard toolbar. If you desire, print your file by clicking the Print
button on the Standard toolbar, or by selecting Print from the File menu. Keep the
file open for the next set of steps.
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HELP: If your previewed file does not resemble Figure A-27, you may need to adjust the
location of the split bar between the Entry table and the Gantt chart. The entire
Predecessors column must be visible in the Gantt Chart view for it to show up in the Print
Preview. Close the Print Preview and move the split bar to reveal the entire column, and
then select Print Preview again. Also make sure your timescale is correct. You should not
print a Project file until the Print Preview displays the desired information.

Gantt Charts, Network Diagrams, and Critical Path Analysis
Project 2007 shows a Gantt chart as the default view to the right of the Entry table. As
described earlier in this text, network diagrams are often used to show task dependencies.
This section explains important information about Gantt charts and network diagrams and
describes how to make critical path information more visible in the Gantt Chart view.

Because you have already created task dependencies, you can now find the
critical path for Project A+. You can view the critical tasks by changing the color of those
items in the Gantt Chart view. Tasks on the critical path will automatically be red in the
Network Diagram view. You can also view critical path information in the Schedule table
or by using the Critical Tasks report.

To make the text for the critical path tasks appear in red in the Entry table and on
the Gantt chart:

1. Using the schedule.mpp file you previously saved, open the Text Styles dialog
box. Click Format on the Menu bar, and then click Text Styles. The Text Styles
dialog box opens.

2. Change the critical tasks color option to red. Click the Item to Change list
arrow, and then select Critical Tasks. Click the Color list arrow, and then select
Red, as shown in Figure A-28. Click OK to accept the changes to the text styles.
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Select Critical Tasks Select Red

Figure A-28. Displaying critical tasks in red

3. Open the Gantt Chart Wizard. Click Format on the Menu bar and then select
Gantt Chart Wizard. The Gantt Chart Wizard opens. Click Next, and the next
step of the wizard appears.

4. Select the Critical Path option. Click the Critical path radio button, as
shown in Figure A-29. Notice that the sample Gantt chart in the Gantt Chart
Wizard displays some bars in red, representing tasks on the critical path. Click
Finish to proceed to the next step in the Gantt Chart Wizard.
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Figure A-29. Gantt chart wizard showing critical path format

5. Format the Gantt chart. Click Format It, and then click Exit Wizard.
Critical taskbars on the Gantt chart will now be red. Task information and bars
for all the critical tasks should be displayed in red on your computer screen.
Notice that working on deliverables 1 and 3 are on the critical path while
working on deliverable 2 is not.

6. View the network diagram. Click the Network Diagram button on the View
Bar or select Network Diagram from the View menu. To see more tasks in the
Network Diagram view, click the Zoom Out button one or more times. You can
also use the scroll bars to see different parts of the network diagram. Figure A-30
shows all of the tasks in the Project A+ network diagram. Note that milestone
tasks, such as Stakeholder management strategy completed, the fourth box on the
top, appear as pointed rectangular boxes, while other tasks appear as rectangles.
Move your mouse over that box to see it in a larger view. Notice that tasks on the
critical path automatically appear in red, while noncritical tasks appear in blue. A
dashed line on a network diagram represents a page break. You often need to
change some of the default settings for the Network Diagram view before
printing it. As you can see, network diagrams can be messy, so you might prefer
to highlight critical tasks on the Gantt chart as you did earlier for easier viewing.
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Figure A-30. Network diagram view

7. View the schedule table. Click the Gantt Chart button on the View Bar to
return to Gantt Chart view. Right-click the Select All button to the left of the
Task Name column heading and select Schedule. Alternatively, you can click
View on the Menu bar, point to Table: Entry, and then click Schedule. The
Schedule table replaces the Entry table to the left of the Gantt chart. Move the
split bar to the right until you see the entire Schedule table. Your screen should
resemble Figure A-31. This view shows the start and finish (meaning the early
start and early finish) and late start and late finish dates for each task, as well as
free and total slack. Right-click the Select All button and select Entry to return
to the Entry table view.
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Select All button Schedule table

Figure A-31. Schedule table view

8. Open the Reports dialog box. Click Report on the Menu bar, and then click
Reports. Double-click Overview to open the Overview Reports dialog box, and
then double-click Critical Tasks. A Critical Tasks report as of today’s date is
displayed, as shown in Figure A-32.
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Figure A-32. Critical tasks report

9. Close the report and save your file. When you are finished examining the
Critical Tasks report, click Close. Click Close on the Reports dialog box. Click
the Save button on the Standard toolbar to save your final schedule.mpp file.
Close Project 2007 if you are not continuing to the next section.

HELP: If you want to download the Project 2007 file schedule.mpp to check your work
or continue to the next section, a copy is available on the companion Web site for this
text, the author's Web site, or from your instructor.

Next you will explore some of the cost and resource management features of
Project 2007.

PROJECT COST AND RESOURCE MANAGEMENT
Many people do not use Project 2007 for cost or resource management. Most
organizations have more established cost management software products and procedures
in place, and many people simply do not know how to use the cost or resource
management features of Project 2007. However, these features of Project 2007 make it
possible to integrate total project information more easily. This section offers brief
instructions for entering fixed and variable cost estimates, assign resources to tasks, view
resource histograms, and enter actual cost and schedule information after establishing a
baseline plan. It also explains how to use Project 2007 for earned value management.
More details on these features are available in Project 2007 Help, online tutorials, or
other texts.
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Entering Fixed and Variable Cost Estimates
You can enter costs as fixed or variable. Fixed costs include costs like material purchases.
For example, you might buy a new software program specifically for a project or hire a
consultant for a fixed fee. Variable costs can apply to materials or human resources. On
many projects, human resource costs are the largest percentage of total project costs.

Entering Fixed Costs in the Cost Table
The Cost table allows you to easily enter fixed costs related to each task. You will enter a
fixed cost of $200 related to Task 15, Work on deliverable 1.

To enter a fixed cost:

1. Display the Cost Table view. Open your Project 2007 file schedule.mpp, if
necessary. Right-click the Select All button to the left of the Task Name column
heading and select Cost. Alternatively, you can click View on the Menu bar,
point to Table: Entry, and then click Cost. The Cost table replaces the Entry
table to the left of the Gantt chart. Widen the Task Name column and move the
split bar to the right until you see the entire Cost table.

2. Enter a fixed cost. In the Fixed Cost column for Task 15, Work on
deliverable 1, type 200 and press Enter. Notice that the Total Cost and
Remaining Cost columns reflect this entry. Your screen should resemble Figure
A-33.

Select All button Fixed Cost column of cost table

Figure A-33. Entering a fixed cost
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Entering Resource Information and Cost Estimates
Several methods are available for entering resource information in Project 2007. The
Resource Sheet allows you to enter the resource name, initials, resource group, maximum
units, standard rate, overtime rate, cost/use, accrual method, base calendar, and code.
Once you have established resources in the Resource Sheet, you can assign those
resources to tasks in the Entry table with the list arrow that appears when you click a cell
in the Resource Names column. The Resource Names column is the last column of the
Entry table. You can also use other methods for assigning resources, such as using the
toolbar or using the split window, which is the recommended approach to have the most
control over how resources are assigned because Project 2007 makes several assumptions
about resources assignments that might mess up your schedule or costs. Next, you will
enter information for three people working on Project A+ and assign them to a few tasks
using various methods.

To enter basic information about each person into the Resource Sheet and assign
them to tasks using the Entry table and toolbar:

1. Display the Resource Sheet view. Click the Resource Sheet button on the
View Bar (you may need to scroll to see it), or click View on the Menu bar, and
then click Resource Sheet.

2. Enter resource information. Enter the information from Figure A-33 into the
Resource Sheet. The three resources names are Kathy, Dan, and Scott. The Std.
Rate and Ovt. Rate for Kathy is 40, and the Std. and Ovt. Rates for Dan and Scott
are 30. Type the information as shown and press the Tab key to move to the next
field. When you type the standard and overtime rates, you can just type the
number, such as 40, and Project 2007 will automatically enter $40.00/hr. The
standard and overtime rates entered are based on hourly rates. You can also enter
annual salaries by typing the annual salary number followed by /y for “per year.”
Your screen should resemble Figure A-34 when you are finished entering the
resource data.

Figure A-34. Resource sheet view with resource data entered
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TIP: If you know that some people will be available for a project only part time, enter
their percentage of availability in the Max Units column of the Resource Sheet. Project
2007 will then automatically assign those people based on their maximum units. For
example, if someone can work only 50% of his or her time on a project throughout most
of the project, enter 50% in the Max Units column for that person. When you enter that
person as a resource for a task, his or her default number of hours will be 50% of a
standard eight-hour workday, or four hours per day. You can also enter the number of
hours each person is scheduled to work, as shown later.

3. Assign resources to tasks. Click the Gantt Chart view on the View bar, and
then click the Select All button and switch back to the Entry table. Widen the
Task Name column and move the split bar to reveal all of the entry table
columns, if needed.

4. Assign Kathy to task 2, Identify stakeholders. Click in the Resource Names cell
for row 2. Click the list arrow, and then click on Kathy. Notice that the resource
choices are the names you just entered in the Resource Sheet. Also notice that
after you select a resource, his or her name appears on the Gantt chart, as shown
in Figure A-35. To assign more than one resource to a task using the list arrow,
type a comma after the resource name and select another. Note that Project 2007
will assume that each resource is assigned full-time to tasks using this method.

Figure A-35. Resource assigned using the entry table

5. Assign all three resources to a task using the toolbar. Click the task name for
Task 5, Prepare project charter. . Click the Assign Resources button on the
toolbar. (If the Assign Resources button is not visible, click the Toolbar Options
button on the toolbar, and then click the Assign Resources button. You can also
press Alt+F10.) The Assign Resources dialog box, which lists the names of the
people assigned to the project, is displayed, as shown in Figure A-365. You could
select one resource at a time and click Assign, or click on the first name, hold
down the Shift key, click on the last name to select all of the names at once, and
then click Assign. Notice that all three resource names appear in the Resource
Names column and on the Gantt chart for this task.
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TIP: Project 2007 assumes resources are all assigned full-time to tasks using the Entry
table and toolbar methods. Also, if you change the number of resources assigned to tasks,
Project 2007 will change the task duration since it assumes tasks durations are resource-
driven. This is why the split window method is highly recommended for assigning
resources.

Assign Resources icon

Figure A-36. Assign resources dialog box

6. Clear the resource assignments. View the cost table again by right-clicking
the Select All button and selecting Cost. Notice how much money is being
charged to the tasks where resources were entered. Project assumes that resources
are assigned full-time to tasks, which is not what you want to do here. Right-click
the Resource Names column for Task 2, and then select Clear Contents to
remove the resource assignments. Do the same for Task 5.
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TIP: Project 2007 includes a multiple-level undo feature, so you can click the Undo
button on the standard toolbar several times to undo several steps in your file. For
example, if you notice that your resources assignments are incorrect, you can undo them
or clear them. Again, it is highly recommended that you use the split window method
shown in the following steps to assign resources so you make sure you enter them
correctly.

To assign resources using the split window:

1. Split the window to reveal more information. Click Window on the Menu
bar, and then click Split. The Cost Table and Gantt Chart view is displayed at the
top of the screen and a resource information table is displayed at the bottom of
the screen.

2. Open the Resource Cost window. Right-click anywhere in the bottom
window and select Resource Cost. 3. Assign Kathy to Task 2 for 10 hours.
Select Task 2, Identify stakeholders in the top window, and then click the first
cell in the Resource Name column in the Resource Cost window. Click the cell’s
list arrow and select Kathy. Press Enter. Type 10h or use the list arrow to select
10h in the Work column.

3. Remove the Effort driven option. Uncheck the Effort driven box in the
lower window so Project does not change task durations based on resource
entries for that task. Your screen should resemble Figure A-37.

Resource Name column in Resource Cost window Cost Table window

Work column    Effort driven option

Figure A-37. Split screen view for entering resource information
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4. Enter the resource assignment and review the Gantt chart. Click OK in the
Resource Cost window. Notice that the duration for Task 2 is still one week, and
Kathy is assigned to that task. Also notice that the costs make sense now for Task
2 since only 10 hours of Kathy’s time are being assigned to it instead of 40 hours
for full-time work for the week.

5. Close the file without saving it. Close the file, but do not save the changes
you made.

Entering Baseline Plans, Actual Costs, and Actual Times
After entering tasks in a WBS, establishing task durations and dependencies, and
assigning costs and resources, you are ready to set a baseline plan. By comparing the
information in your baseline plan to an updated plan during the course of the project, you
can identify and solve problems. After the project ends, you can use the baseline and
actual information to plan similar, future projects more accurately. To use Project 2007 to
help control projects and view earned value information, you must establish a baseline
plan, enter actual costs, and enter actual durations. In the next series of steps you will use
a new file called tracking.mpp that downloaded from the companion Web site for this
text (http://groups.google.com/group/intropm ) or the author’s personal Web site
(www.kathyschwalbe.com).

To save a file as a baseline and enter actual information:

1. Open the file called tracking.mpp. Notice that this project was planned to
start on January 5 and end on February 13, have three resources assigned to it,
and cost $11,200. Click Tools on the Menu bar, point to Tracking, and then
click Set Baseline, as shown in Figure A-38.

Figure A-38. Saving a baseline

2. Save the file as a baseline. Examine the Set Baseline dialog box. Click the
drop-down arrow to see that you can set up to ten baselines. Accept the default to
save the entire project. Click OK. Notice that the Baseline column changes to
blue.

http://groups.google.com/group/intropm
www.kathyschwalbe.com
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3. Display the Tracking toolbar. Click View on the Menu bar, point to
Toolbars, and then click Tracking. Move the toolbar if desired. Move your
mouse over each button the Tracking toolbar to see what it is called.

4. Display the Tracking table. Right-click the Select All button in the Entry
table, and then click Tracking to see more information as you enter actual data.
Widen the Task Name column to see all of the text, and then move the split bar to
reveal all the columns in the Tracking table. Your screen should resemble Figure
A-39.

Tracking toolbar Tracking table

Figure A-39. Using the tracking table and tracking toolbar

5. Mark Tasks 2 though 4 as 100% complete. Click the Task Name for Task
2, Subtask 1 under Main task 1, and drag down through Task 4 to highlight
those tasks. Click the 100% Complete button on the Tracking toolbar. The
columns with dates, durations, and cost information should now contain data
instead of the default values, such as NA or 0. The % Comp column should
display 100%. Adjust column widths if needed. Your screen should resemble
Figure A-40. Notice that the Gantt chart bars for those three tasks now have a
blank line through them.

Figure A-40. Tracking table information

6. Enter actual completion dates for Task 6. Click the Task Name for Task
6, Subtask 1 under Main task 2, and then click the Update Tasks button on
right side of the Tracking toolbar next to the 100% button. The Update Tasks
dialog box opens. For Task 6, enter the Actual Start date as 1/26/09 (the same
as the Current start date) and the Actual Finish date as 2/9/09 (later than the
Current finish date), as shown in Figure A-41. Click OK. Notice how the
information in the tracking sheet has changed.
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Figure A-41. Update tasks dialog box

7. View the Tracking Gantt chart. Click View on the Menu bar, and then
click Tracking Gantt. Alternatively, you can click the Tracking Gantt
button on the View Bar, if it is displayed. Use the horizontal scroll bar in
the Gantt chart window (move it to the left) to see symbols on the Tracking
Gantt chart. Also move the split bar and adjust column widths as needed.
Your screen should resemble Figure A-42. The blue bar for task 6 shows the
actual time you just entered. Notice that the delay in this one task on the
critical path has caused the planned completion date for the entire project to
slip. Also notice the Indicator column to the far left. The check marks show
that tasks are completed.

Figure A-42. Tracking Gantt chart view

8. Save your file as a new file named actuals.mpp. Click File on the Menu bar,
and then click Save As. Name the file actuals, and then click Save.

Notice the additional information available on the Tracking Gantt chart.
Completed tasks have 100% by their symbols on the Tracking Gantt chart. Tasks that
have not started yet display 0%. Tasks in progress, such as Task 5, show the percentage
of the work completed (35% in this example). The project summary task bar indicates
that the entire project is 57% complete. Viewing the Tracking Gantt chart allows you to
easily see your schedule progress against the baseline plan. After you have entered some
actuals, you can review earned value information for the initiating tasks of this project.
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VIEWING EARNED VALUE MANAGEMENT
Earned value management is an important project management technique for measuring
project performance. Because you have entered actual information, you can now view
earned value information in Project 2007. You can also view an earned value report using
the new visual reports feature in Project 2007.

To view earned value information:

1. View the Earned Value table. Using the actual file you just saved (or
downloaded from the companion Web site), click View on the Menu bar, point to
Table: Entry, select More Tables, and double-click Earned Value. Move the
split bar to the right to reveal all of the columns, as shown in Figure A-43. Note
that the Earned Value table includes columns for each earned value acronym,
such as SV, CV, etc., as explained in this text. Also note that the EAC (Estimate
at Completion) is higher than the BAC (Budget at Completion) starting with Task
6, where the task took longer than planned to complete. Task 9 shows a VAC
(Variance at Completion) of ($3,360.00), meaning the project is projected to cost
$3,360 more than planned at completion at that point in time. Remember that not
all of the actual information has been entered yet. Also note that the date on your
computer must be set later than the date of a completed task for the data to
calculate properly.

Figure A-43. Earned value table

2. View the earned value chart. Click Report on the Menu bar, and then click
Visual Reports to open the Visual Reports dialog box. Click Earned Value
Over Time Report, as shown in Figure A-44. Notice the sample of the selected
report on the right side of the dialog box. If you have Excel, click View to see the
resulting report as Project 2007 automatically creates Excel data and a chart
based on your current file. Close Excel without saving the file, and then click the
Close button of the Visual Reports dialog box.
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Figure A-44. Visual reports dialog box

3. Save and close the file. Click the Save button on the Standard toolbar, and
then close the tracking.mpp file. You can also exit Project 2007 and take a break,
if desired.

HELP: To use all of the visual reports features, you must have .Net Framework 2.0,
Excel 2007, and Visio 2007 installed on your computer. You may also need to adjust data
in Excel, such as displaying weeks or months versus quarters, to get the reports to display
as desired.

Next you will use a few more features of Project 2007 to help tie your Project to
your other project documents.
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INTEGRATING PROJECT 2007 WITH OTHER
APPLICATIONS
Project 2007 provides many different tables, views, reports, and formatting features to aid
in project communications, as you have seen in the previous sections. This section
highlights some common reports and views. It also describes how to insert hyperlinks
within Project 2007 to other project documents, and how to use the copy picture feature
to insert Project 2007 screens into other documents.

Common Reports
As you have seen, you can easily change and print out various table views in Project
2007, such as the Entry Table, Cost Table, Schedule Table, and so on. Many different
reports are also available in Project 2007, categorized as follows when clicking Reports
on the Menu bar, and then Reports, as shown in Figure A-45.

Figure A-45. Reports dialog box

 Overview reports include:

 Project Summary

 Top-Level Tasks

 Critical Tasks

 Milestones

 Working Days



56

 Current Activities reports include:
 Unstarted Tasks
 Tasks Starting Soon
 Tasks In Progress
 Completed Tasks
 Should Have Started Tasks
 Slipping Tasks

 Cost reports include:

 Cash Flow

 Budget

 Overbudget Tasks

 Overbudget Resources

 Earned Value

 Assignments reports include:

 Who Does What

 Who Does What When

 To-do List

 Overallocated Resources

 Workload reports include:

 Task Usage

 Resource Usage

 Custom allows you to customize and save your own report formats.

By selected Visual Reports from the Report menu, as shown earlier in Figure A-
44, you can access the following types of reports:

 Baseline Cost Report

 Baseline Work Report

 Budget Cost Report

 Budget Work Report

 Cash Flow Report

 Earned Value Over Time Report

 Resource Cost Summary Report
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 Resource Remaining Work Report

 Resource Work Availability Report

 Resource Work Summary Report

Feel free to experiment with the various reports available in Project 2007 or to
create your own.

Creating Hyperlinks to Other Files
Some people like to use their Project 2007 file as a main source of information for many
different project documents. To do this, you can simply insert a hyperlink to the
documents you listed as part of your WBS. For example, you can create a hyperlink to
the file with the stakeholder register you listed as a milestone in your Task Name column
earlier.

To insert a hyperlink within a Project 2007 file:

1. Open the schedule.mpp file. Use the file you saved earlier or download it
from the companion Web site for this text. The Entry table and Gantt Chart view
should display.

2. Select the task in which you want to insert a hyperlink. Click the Task Name
for Task 3, Stakeholder register completed.

3. Open the Insert Hyperlink dialog box. Click Insert on the Menu bar, and
then click Hyperlink. Alternatively, you can right-click the task name and select
Hyperlink or click the hyperlink button on the toolbar. The Insert Hyperlink
dialog box opens, as shown in Figure A-46. You will have different folders
visible based on your computer’s directory structure.
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Figure A-46. Insert hyperlink dialog box

4. Double-click the filename of the hyperlink file. Change the Look in:
information until you find where you have saved the files you downloaded for
this appendix. Double-click the Word file named stakeholder_register, and then
click OK. A Hyperlink button appears in the Indicators column to the left of the
Task Name for Task 3. Move your mouse over the hyperlink button until the
mouse pointer changes to the Hand symbol to reveal the name of the hyperlinked
file. If you click on it, the file will open.

Using the Copy Picture Feature
The Copy Picture feature helps you easily copy images from Project 2007 into other
applications. After answering a few questions in the wizard, you can quickly display
project data as a static picture in Office applications, including PowerPoint, Word, and
Visio. You can access this wizard on the Analysis toolbar.

To use the Copy Picture feature:

1. Prepare the file you want to copy. Again using the schedule file, adjust screen
elements so your screen resembles Figure A-47. You may need to remove some
of the toolbars by selecting Tools from the Menu bar and unchecking them to get
the entire image to show on your screen. Drag the split bar so the entire
Predecessors column is showing. Click in the Task Name column for task 0.
Make sure you can see the entire Gantt chart on your screen.
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Figure A-47. File ready for copy picture feature

2. Open the Copy Picture dialog box. Click Report on the Menu bar, and then
click Copy Picture to display the Copy Picture dialog box. Keep the default
settings. Click OK.

3. Open the application where you want to copy the picture and paste it in.
Open a new file in Microsoft Word, or another application, if desired. Copy the
picture of your Project 2007 file by pressing Ctrl+V or using another method to
paste the picture. Figure A-48 shows the resulting picture in a Word file.

Figure A-48. Project 2007 picture copied into Microsoft Word

4. Close all open windows. Click the Close button on any open windows. You
do not need to save any of the open files.
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You have really just touched the surface of Project 2007’s powerful features, but
you probably know more than most people who have this software! There are several
books with more detailed information on using Project 2007 that you can use to learn
even more, or you can experiment with the software and Help feature to understand it
more.
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DISCUSSION QUESTIONS
1. What are some unique features of project management software?

2. How do you create a WBS in Project 2007?

3. How do you enter task durations and establish dependencies between tasks?

4. What is the recommended method for assigning resources to tasks? Why is it the
preferred method?

5. How do you establish a baseline in Project 2007 and enter actual information?

6. What are some of the reports built-in to Project 2007? Which ones do you think
are commonly used?

7. How do you create links to other files from within Project 2007? How can you
easily copy an image of a screen from Project 2007 into another application?

EXERCISES
1. To make sure you understand the information in this appendix, perform the steps

yourself. Print out the following screens or send them to your instructor, as
directed:
a. The Schedule table view for the Customer Feedback file, similar to

Figure A-11.
b. The Customer Feedback file filtered to show only milestones, similar to

Figure A-14.
c. The wbs file without the Closing tasks indented. Also type your first and

last name after the word Initiating, the first Task Name.
d. Create a new Project file called mywbs that shows the WBS for a generic

project. Make the main categories phase 1, phase 2, phase 3, and phase 4.
Include at least four tasks and one milestone under each of these main
categories. Enter 0 for the duration of the milestones, but do not enter
any durations for the other tasks. Be sure to indent tasks and show the
outline numbers before printing.
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2. Continue performing the steps in this appendix, starting with the section called
Developing the Schedule. Print out the following screens or send them to your
instructor, as directed:
a. The schedule file with durations and dependencies entered, similar to

Figure A-27. Type your first and last name after the word Initiating, the
first Task Name, before printing or handing in the file.

b. The top window showing the Cost table, similar to Figure A-37. Again
type your name after the word Initiating, the first Task Name.

c. Continue performing the steps, even if you do not have to print out more
screens.  Write a one-to-two page paper describing the capabilities of
Project 2007 and your opinion of this software. What do you like and
dislike about it?

3. Use some of the information in the body of this text to practice your Project 2007
skills.
a. Review the sample WBS for the Just-In-Time Training project provided

in Chapter 4, Figure 4-10. Enter the WBS into Project 2007. Indent tasks
and use the automatic numbering feature. Print or hand in your file.

b. Use the information in Figure 4-14 for Project X to create a Gantt chart,
as shown in Figure 4-18. Also create the network diagram for Project X,
as shown in Figure 4-16. Make sure both will print out on one page each,
then print or send them to your instructor Assume the start date was
6/9/09, or June 9, 2009.

c. Make up actual information for Project X. Assume some tasks are
completed as planned, some take more time, and some take less time.
View and then print out or hand in the tracking Gantt chart.

4. If you are doing a team project as part of your class or for a project at work, use
Project 2007 to create a detailed file describing the work you plan to do for the
project.

a. Create a detailed WBS, including several milestones, estimate task
durations, link tasks, enter resources and costs, assign resources, and so
on. Save your file as a baseline and print it out send it to your instructor,
as desired.
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b. Track your progress on your team project by entering actual information.
Create a new baseline file if there have been a lot of changes. View
earned value information when you are halfway through the project or
course. Continue tracking your progress until the project or course is
finished. Print or send your Gantt chart, Project Summary report, Earned
Value table, and relevant information to your instructor.

c. Write a two- to three-page report describing your experience. What did
you learn about Project 2007 from this exercise? How do you think
Project 2007 helps in managing a project? You may also want to
interview people who use Project 2007 for their experiences and
suggestions.

COMPANION WEB SITE
Visit the companion Web site for this text to access more information related to project
management, such as template files, links to sites related to project management, and
other information to help you learn more about this important field. Instructors must
contact the author at schwalbe@augsburg.edu to gain access to the instructor site.
Anyone can access the student site. Below are the urls for each site:

 Instructor Site: http://groups.google.com/group/teachintropm
 Student Site: http://groups.google.com/group/intropm

END NOTES
1TopTenREVIEWS™, “Project Management Software,” (http://project-management-
software-review.toptenreviews.com) (accessed June 17, 2009).
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